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PURDUE

LUCIDPRESS —
BROWSER COMPATIBILITY:

Optimized for
Google Chrome

- Compatible with Firefox

« Not currently compatible
with Safari

2 DURDYE

USER GUIDE

Purdue Marketing and Communications has created a

collection of in-brand layout templates on Lucidpress.com.

Having consistent and cohesive designs in your
communications and marketing materials will:

¢ Instill a defining look and feel of Purdue’s brand in
your pursuit of the next giant leap.

¢ Remind your audiences of Purdue’s forward-looking
approach with your innovative design.

e Capture key elements of each unique project while
maintaining the University’s uniform brand design
and essence.

Here are some basics and tips and tricks to assist you in
implementing the new Purdue brand through your printed
communications and marketing materials.
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Purdue Brand Template Gallery

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE

Sampling of Digital Templates = g
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CATEGORIES
Agenda/Schedule

Purdue Moves Present... Report (1-column) Repnrg(z-mlumn) Digital S?gn (Four Wind... Digital s?gn (Four Wind...
Calendar x9in .5x11in .5x11in .67 x15in .67 x15in
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PRINT

Purdue Brand Template Gallery

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE

BROCHURE o
TILE -

e

Sampling of Print Templates

Click placeolder box
to Insert image

CATEGORIES

A-Fl’a me Slgn NOteca rd 8-Page Profile Brochure Agenda: 1 Day (Print) :g:‘:‘l“:‘ 2-Day (Print) H Agenda: 3-Day (Print) Awards Program (16 p...
Agenda/SChedule Rack Card 85x11in 85x11in 85x1Lin 118500

Award/Certificate  Poster

Brochure Program
Calendar Stationery = = |
- SMALL HEADING TEXT

Flyer Table e : BIG HEADING TEXT

[happy| - - "
Half-Sheet Tent Card BIRTHDAY
Newsletter — :

!irthd_:y Card: A6 1 !irllld_:y Card: A6 2 Birlhd.:y Card: A6 3 Brand Certificate Brand ?nnnrd Mailer

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE
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Brand Trifold Brochure 1 Brand Trifold Self-Mail... Bullet List Flyer (2-sided) Business Profile Flyer (... Co-Brand Certificate
11x85in 11x85in 85x1lin 85x1lin 11x85in
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Purdue Brand Template Gallery | DIGITAL / PRINT / SOCIAL |

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE

Sampling of Social Templates

READINE
Subhesd

CATEGORIES

Fa ce boo k Congratulations-Faceb... Congratulations-1G Congratulations-Twitter Facebook - Black Slants Facebook - Grey Slants
16.67x8.75in 15x15in 16.67 x 9.38in 16.67x8.75in 16.67x8.75in
Instagram
.
Linked In
Twitter

Social Profile Icon

== By 123
= = WROVAING_

FB Post: Image (1200x... FB Post: Image-Quote (... FB Post: Image-Text (1... FB Post: Proof Pt 1 (12... FB Post: Proof Pt 2 (12...
16.6Tx8.75in 16.67x8.75in 16.67x8.75in 16.67x8.75in 16.67x8.75in

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE

Single e

FB Post: Save the Date ... FB Post: Text-Quote (1... FB Social Profile Icon: ... FB Social Profile Icon: ... 1G Post: Image (1080x1...
16.6Tx8.75in 16.67x8.75in 25x25in 25x2.5in 15x15in
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Lucidpress Home Page

2

= Thisis a basic home page, and you can find yours by

USER GUIDE

clicking on the Motion P in the upper left, or on the
4-square grid in the left navigation.

2 Purdue Univ...

7 =) PURDUE

UNIVERSITY

Welcome back

Recent Starred Popular
1l Pop

Co-Brand Postc...

What would you like to do?

Some of the most common things are editing and organizing current

ting a new document from a Brand Template.

docum orcreal

Start designing by selecting a

Brand Template.

Brand Templates

Agenda: 2-Day (... Black history m...

Marketing and Communications

Brand Fonts

= Purdue’s brand fonts have been added to the
Brand Assets in Lucidpress. You don't need to
have the fonts installed on your computer in
order for them to work in Lucidpress.

Brand Colors

= Purdue’s brand colors have been added to
the Brand Assets.

The CMYK color palette is listed, which is for
print jobs. This is followed by the RGB colors,
for digital and social projects.
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Select a Brand Template

= In the Content Pane, on the left side
of the window, click on Templates to
view the brand templates.

= Browse the brand templates,
which is the icon with the star.

= You can narrow your search by using
the Filters column.
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CONTENT PANE

7 Purdue Univ...

| Home
My Documents
G mages
€ Brand Assets
£ DataAutomation
&7 Account

B cart

© Help Center

SEARCH FILTERS

Templates

Q2 0 4

= placed in: My Documents

W Starred

Search Filters

* Campaign
Protect Purdue

Purdue Moves.

v Media
Digital
Print
Social

* Print Format
Flyer
Note Card [Folded-A5)
Brochure
Posteard
Agenda/Schedule
Arame
Letterhead/Stationery
Half-Sheet

™ See More

¥ Social Media
Facebook
Instagram
Linkedin
Twitter

Social Profile loon

* Digital Format

Digital Sign (Four Winds) 8

Agenda/Schedule
Report

Video Storyboard
Presentation
Website Banner
Calendar

Zoom Background

~ SeeMore

* Document Size

v nofPages
1page

2pages
8 pages

4
2
2
2
1
1

H = INSPIRING = = :

m Post: Imal! (1080x1... If;ilnry |m.g-|mux 1aPox; Img! Text 1., Event Flyer: 1 Speaker Story Flyer (2-sided)
51 85x1lin 85x11ir

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE

gl = =
= =

Graphic Pastcard (1sid... Bullet List Flyer (2-sided) Multi-Photo Fiyer (2 si... FB Post: Image-Text (1... FB Post: Image (1200x...
5 85x1lin 85100 1667875 1657 x8T5in

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE

= SAVE
' THE DATE
i
00/00/00

Business Profile Fiyer ... TW Post: Image (1200x... Giant Leap Oversize Po... Presentation: Standar... 1G Post: Save the Date ...
85K 110 1667038 105 6ir 10x7.51n 15%15in

TEMPLATE TEMPLATE TEMPLATE TEMPLATE TEMPLATE

RANKED

SMALL HEADING TEXT SWALL HEADNNG TEXT

BIG HEADING TEXT BIG HEADING TEXT

Agenda: 1 Day (Print) 1G Post: Ranking (1080... TW Post: Image-Text (1... Co-Brand Pastcard Mailer Brand Posteard Mailer
85x11in 15x15in 6.67%9.381n 853550 8545500
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Preview or open a Brand Template

m Hover over a template and click the —
TEMPLATE ’
Co-Brand Flyer (Bullet Lists)

Preview button.

Co-Brand Logo, Flyer, No

85x1lin

2 pages

= A new document can be opened
from the template gallery or from the
Preview window.

Co-brand flyer with bullet lists

85x11

Portrait

=
PURDUE 2EeT

© Preview

/2
.
: { Preview Previous Template Preview Next Template )

OPEN NEW OPEN NEW
DOCUMENT DOCUMENT

PURDUE Marketing and Communications
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Create Document from Template

= Rename the document in the Save as field.

« Click on Create Document. Create Document From Template X
= All new documents will save to the Save As ‘ Co-Brand Flyer (Bullet Lists) ]
My Documents folder or a sub-folder that
Location ‘ - My Documents v ’

you have created.

Cancel ’ Create Document
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Document Workspace

MAIN MENU BAR

= When a document is open in the

Lucidpress workspace, you will see the | [t
main menu bar in the top navigation.
This gives you access to settings within o HICH : ==
the document: File, Edit, Select, View, o
Page, Arrange, Insert and Help.

=

= On the left side is the content pane,
which contains tools to help develop
your layout. You can add pages, text,
shapes, images, charts, buttons and
videos.

GUEST SPEAKER NAME B
TIME | DATE

Short, concise description of
event here. Utatem dolor as

ex est pre alique volecea
doluptat quis dolliquia
dolumen iminis dignihi
lluptatur, susant quo optat.

CONTENT PANE

Add a New Page

E PURDUE Marketing and Communications

UNIVERSITY



PURDUE BRAND TEMPLATES 1 ceen susoe

Working with Text

There are a couple ways to add text: EDIT PLACEHOLDER
TEXT

IMPORT TEXT
FROM DRIVE

= All of the templates contain placeholder text
which you can customize with your content.

» :)Iigit:ajlfi%n(F’ou.!'win?s]:i?m7 : : - ]
fle Edit Select View Pope Amange lnsert Hel

m Upload a Word document to a Google drive.
Unnder the Insert tab in the top nav, select
Import Text from Drive.

B 0 ¥ ?

P 0 @ B &

E PURDUE
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Working with Text (continued)

= When text is imported, the line spacing
(called leading) looks tight. Select your
text, and the “Text" menu appears on the
right side of the window. Find the Spacing
settings, and increase the spacing to 1 line
or more.

= Lucidpress has a Spell Check feature,
indicated by words underlined in red.
This can be turned on and off in the
Edit menu in the top navigation.

Marketing and Communications

E PURDUE
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Click placeholder box
to insert image
or remove box if
not needed

GUEST SPEAKER NAME
TIME | DATE
" sfiart; concise description of, (] [l
| event here. Utatem dolor as,
ex est pre alique volecegy

doluptat quis dolliquia

dolumen iminis dignihi
] a

SPACING MENU

Text Shapz Layout
~ Fonts

35pt
BIU T
EE=EE=E T L

» Paragraph Styles

» Bullets & Lists VE > = -

v Spacing 1= L2lines 3]
1= oin s Z[oin
PARAGRAPH TOP SPACING
=l oin
PABDING
AV[i00% 2 Al1wo% *
CHARACTER STRETCHING
» Columns \ 1
» Tabs & Indents e 9=
» Horizontal Rules
» Warp None A
» Link
Hyphenation
Layers

SPELL CHECK

Digital Sign (Four Winds): Ev ...
File| Edit |Select View Page Arrange Insert Help (©) Savec

to insert imag
v or remove box
not needed

| ~/ Spell Check

Change Spell Check Language

Find & Replace
GUEST SPEAKER

TIME

Short, concise descri
event here. Utatem ¢
ex est pre alique |
doluptat quis d

dolumen iminis

REGISTER AT: BITLY LINK
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Paste Text into a Document

2

Pasting text from a Word document into a
template produces white boxes behind the words,
which will be visible on a color background.

If you need to modify this, navigate to Fonts

in the Text tab:

m Click on the capital “T" in the Fonts menu.
Another menu will pop up.

= Then click on the capital “A" with the small
circled X. This will clear formatting on the
text, removing the white background.

= If the font attributes have not been locked
down, the resulting text may be in default
font settings. You may need to re-select the
font style, size and other attributes for your
text.

PURDUE

UNIVERSITY
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| SUBORDINATE COPY

Come and take your first
small step. Then take
another, and another. Over
the next few years, we'll
put you on track

toyourgiant leaps.

WHITE BOXES BEHIND
PASTED TEXT

FORMATTING

-

Normal v | @) sme
CHARACTER STYLES

lines &
OUTLINE H A

GHLIGHT

CLEAR THE TEXT
FORMATTING

13
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Working with Images

= The lmage Manager is located in the Content Pane in
the left column of the window.

= To access the Image Manager, click on images in
the Content Pane, or double-click on an image
placeholder box in your document.

&7 Purdue Univ... R

-
L B My Images

| 22 Home

© Brand Images
& Profile Images

O MyDocuments e

]1? Templates

€ Brand Assets

B DataAutomation
an  Team

&7 Account

E cat

2 7 PURDUE  wiciogunconmncains
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Image File Formats

Lucidpress accepts the following image file formats:
JPG, PNG, SVG.

Color Formats

For print templates, place high-resolution JPG
images in print/CMYK format.

For digital templates, use JPG, PNG or SVG images
saved in digital/RGB format.

14
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Upload Image

= Drag and drop or upload image or
your co-brand logo into the Image

manager.

= You can also upload a folder of
images or SVG files. PDF pages will
convert to an image when uploaded.

= My Images somby v || g v || seachimy a0 ap SPTURDY

1] 7 Details

! ] [t '
P b L i
oo AT B
afs &) "

2B O

Ca e A e,
SR -
= I I -
Bl Drop images here to upload. IS Migiecruil Grus7es M
S

DRAG AND DROP

Select 3 image orfolder to view ts

@
X
Upload A

Images

Folder
SVG Files
Pages from PDF

UPLOAD

OPTIONS

E PURDUE

UNIVERSITY
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Insert Image in Image Box

= Drag and drop image or your co-
brand logo directly into an image
placeholder in your document.

= Use the Insert menu in
the main menu to insert an

image.

Insert | Help Saved

Text Box

——

Video
Scrolling Area
Overlay
Commen t

Guides

Import Text from Drive

Smart Fields

Header

Footer

Creator Name

Document Name

.T- O& 7~ — v opx?

SUGGESTIONS FOR IMAGE SOURCES

= Images from your unit

= Brand or co-brand logos

= Purdue brand photography for campus marketers, located in

Photoshelter photo galleries

15
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Place image in an angled box

m Click on an empty angled photo box.

Fill B

Brand Colors

LS =

= Go to the Fill menu in the Shape tab, which
is to the right of the canvas.

Scale to fill v

IMAGE SCALE

K

EFFECTS CROP

= Select the colored box from the Fill menu, and
a submenu pops up.

= Click Image at the bottom of the Fill menu.

Choose Image

| o

SOLID IMAGE

= Another window pops up. Click Choose
Image to select an image to place in the box. b &

SOLID IMAGE

= Using the Image Manager, select an image
and click insert to place the image in the box.

E PURDUE

UNIVERSITY.
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Crop and Mask an image

Select an image in your document.

CROP & MASK

Click on Crop & Mask in the Image tab in the right
column.

The image will be highlighted, allowing for scaling
and/or repositioning.

5
<
EFFECTS

» Border lopx *]

Hit Enter on your keyboard to exit the cropping view.

» Shadow
» Opacity | 100% »
» Slideshow

» Link

IMAGE HIGHLIGHTED
FOR CROPPING AND
REPOSITIONING

E PURDUE
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Replace an image

= Double-click on an image in your layout INSERT

to open the Image Manager. You'll see
all images that have been uploaded. | —
mage Manager X
= Select a new image and click insert to ® comeroiier e Q [sonty | [ % + load ~

place the image in the box. opr—

€ Brand Images
(3] Profile Images

m Trash

Guy study_grass_su....Jpg MRRT_stdtcrowdo... jpg UHAL _reflect_DSC2....jpg.
1397x2100 2700x1797 . 3600x2400

@ Add Integrations

o625 GBued. Black

!

Marketing and Communications
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Delete an image

= To delete an image from your document, select and
delete it, using the delete key, or Cut, in the Edit menu. The
image is still stored in the image manager or future use.

= To delete an image from your image manager, double-
click the image you'd like to remove.

= The image manager window appears. Hover over your
photo and three vertical dots are shown in the lower right
corner of your photo.

= Scroll down to Trash and click to delete the photo from your
document.

MOVE IMAGE
TO TRASH

: . EMPTY TRASH
= You can also go directly to the image manager to empty

the trash of unneeded photos.

m Items in the trash will still appear in your document layouts
unless you take the additional step of emptying the trash.

Marketing and Communications
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Download your document

= When your document is finished, click the
download icon in the upper right corner.

= Format: Select the appropriate
download option: PDF, PNG, PNG with
transparent background, or JPG
format.

= Resolution: Select Print (300 dpi)
or Screen (72 dpi).

m Color: Select CMYK for print, or
RGB for digital use on screens. There
are several CMYK format options to
choose from. U.S. Web Coated [SWOP]
v2 is commonly used.

= When you finish making all your
selections, click Download.

E PURDUE
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Hitl

Select PDF file format for
most print projects. In some
cases, JPG may be preferred.

RESOLUTION

COLOR
FORMAT

CROP MARKS/
BLEED MARKS

If your document has
color bleeds on the edges,
select Crop Marks and
Bleed Marks for output.

DOWNLOAD FOR
PRINTING

Options

Format

PDF M

I PDF
PNG
PNG (with transparent background)
JPEG

L cuneEmrage

Resolution @

72 0PI 150 DRI 300 DPI

Screen ‘ Retina

Color @

U.S. Web Coated (SWOP) v2 v
Embed Color Profile

Advanced @
() crop Marks

@ Bleed Marks

(®) standard PDF
Print-friendly POF @)
Accessible POF @)

Hi

Select PNG or JPG file
format for digital (web)
and social projects.

RESOLUTION

COLOR
FORMAT

DOWNLOAD FOR
DIGITAL (WEB) OR SOCIAL

Options

Format

PNG v

PDF
| ene
PNG (with transparent background)
JPEG

Current Page

Resolution @

T2DPI 150 DP1 300DP1

Color @

Adobe RGB (1998) v
Embed Color Profile

Advanced @

Crop Marks

Bleed Marks
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Variable data printing through Purdue Enterprise Print Services (Xerox)

If you have a project with variable data, Lucidpress can accommodate
separate text fields for customized information.

Set-up instructions

Create your layout with separate text boxes as placeholders to
identify variable content position placement on the design element.

Include the font style, size and color on the placeholder notation for
the variable content.

Include the fonts with the print file submission.
Provide an Excel file separated by columns for the variable content.

Submit your final print-ready pdf, with all the required content, to
Purdue Enterprise Print Services (PEPS) at https://print.xeps.net/.

Questions? Please contact Kevin Darling at kevin.darling@xerox.com.

2 7 PURDUE  wiciogunconmncains
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Print and Digital Services

PURDUE PRINT PORTAL
https://print.xeps.net/

FILE TRANSFER
http://www.xeps.net/files.html
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